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Revision History  

Date Revised Release Changes Made

8/28/2009 v5.1.3 Avid Unity MediaNetwork v5.1.3 corrects issues that have been reported in 
v5.1.2, see “New in Version 5.1.3” on page 7.

5/28/2009 v5.1.2 Avid Unity MediaNetwork v5.1.2 now includes a Windows® client software 
installer that adds support for the Windows Server 2003 64-bit operating system, 
see “New in Version 5.1.2” on page 8.

4/20/2009 v5.1.2 Avid has started an initiative to characterize a variety of software applications in 
an Avid Unity MediaNetwork shared storage environment. Apple® Final Cut Pro® 
is one of the applications that have been tested. For more information, see “Final 
Cut Pro Software Approved” on page 8.

2/12/2009 v5.1.2 The ATTO Fibre Channel adapter board driver version shipped with the Avid 
MEDIArray XT enclosures and included in the Avid MEDIArray XT recovery 
DVD, is not the version that was qualified in Avid Unity MediaNetwork v5.1.x. 
You must update the ATTO driver on the Avid MEDIArray XT enclosure as part 
of your initial unit setup. 

For the ATTO driver versions supported in this release, see “Fibre Channel 
Adapter Board Firmware and Drivers” on page 28. Instructions for loading the 
ATTO drivers are provided under “Upgrading the ATTO Fibre Channel Driver on 
Clients or Avid MEDIArray Enclosures” on page 42. 

1/23/2009 v5.1.2 Updated the real-time support information between the Digidesign® Pro Tools® 
Windows workstation and Avid Unity MediaNetwork v5.x, see page 25.

1/14/2009 v5.1.2 Avid Unity MediaNetwork v5.1.2 is a Macintosh® client software update which 
provides several software fixes, see “New in Version 5.1.2” on page 8.

11/28/2008 v5.1.1 Avid Unity MediaNetwork v5.1.1 is a full server and client software update which 
provides several software fixes, see “New in Version 5.1.1” on page 10.

Avid Unity™ Media Engine and 
Avid MEDIArray™ XT
Version 5.1.3 ReadMe
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Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before 
installing or using any new software release. Search the Avid Knowledge Base for the most 
up-to-date ReadMe file, which contains the latest information that might have become 
available after the documentation was published. 

The ReadMe describes new features, hardware and software requirements, and information 
you should know before using your Avid Unity MediaNetwork. They also list all known 
hardware and software issues and limitations.

11/28/2008 v5.1 Updated the “Connecting Multiple Avid MEDIArray Enclosures to Two 
MEDIASwitches” section from the Avid Unity Media Engine and Avid 
MEDIArray XT Setup Guide, see “Connecting Multiple Avid MEDIArray 
Enclosures to Two MEDIASwitches” on page 13.

7/17/2008 v5.1 The ATTO CTFC-41EL Fibre Channel adapter board is no longer supported on 
Macintosh Pro clients in Avid MediaNetwork v5.1. The decision was made based 
on complex configurations and resolution limitations, see “Fibre Channel ATTO 
41EL Adapter Board” on page 24.

6/06/2008 v5.1 This release adds support for Macintosh Leopard™ and Windows Vista™ clients. 
Also included is support for 1 terabyte (TB) drives and up to eight drive 
enclosures. For details see “New in Version 5.1” on page 12.

This ReadMe includes changes to the ReadMe included on the Avid Unity 
MediaNetwork v5.1 installer DVD. Changes include:

• More details on the “ATTO Configuration Mode Settings” on page 17

• “Editing Client Requirements for Avid Unity MediaNetwork v5.1.x” on 
page 24

• New issues under “Mac OS X Clients” on page 55

4/15/2008 v5.0.2 Avid Unity MediaNetwork v5.0.2 is for Macintosh clients only. A fix was added 
to avoid a Macintosh kernel panic error, see “New in Version 5.0.2” on page 20.

11/28/2007 v5.0.1 Avid Unity MediaNetwork no longer allows clients to log in to the server using 
earlier versions. For a list for software fixes in v5.0.1, see “New in Version 5.0.1” 
on page 20.
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This ReadMe also provides information about the following servers and clients that use the 
Avid Unity MediaNetwork v5.1.x software:

• Avid Unity Media Engine 

• Avid MEDIArray drive enclosures

• Macintosh Ethernet and Fibre Channel clients

• Windows Ethernet and Fibre Channel clients
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If You Need Help
If you are having trouble using Avid Unity Media Network:

1. Retry the action, carefully following the instructions given for that task. It is especially 
important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published. Also check online for the most up-to-date ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online ReadMe, select ReadMe from the Help menu, or visit the Knowledge 
Base at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

Symbols and Conventions

ReadMe documents use the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

t This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Ctrl+drag.

media engine This term is the generic term used for the Avid Unity Media Engine 
hardware.

http://www.avid.com/onlinesupport
http://www.avid.com/readme 


Accessing Online Support

7

Accessing Online Support

Avid Online Support is available 24 hours per day, 7 days per week. Search the Knowledge 
Base to find answers, to view error messages, to access troubleshooting tips, to download 
updates, and to read/join online message-board discussions.

To access Avid Online Support:

t Go to www.avid.com/onlineSupport/.

New in Version 5.1.3

Avid Unity MediaNetwork v5.1.3 is a both a server and client software release. The software 
for this release is only available on the Avid Download Center. Avid Unity MediaNetwork 
v5.1.3 client software is supported in v5.1.3, v4.2.4, and v4.1.6 infrastructures. The 
following changes were made:

Fixed in Version 5.1.3

Avid Unity MediaNetwork v5.1.3 includes the following client fixes: 

➤ Virtual File Manager was renaming the Computer Name by appending an FC to the end of 
the Computer Name. The Virtual File Manager now stays with the name assigned by the 
administrator.

➤ When in an Avid Unity MediaNetwork v4.x environment with a failover File Manager, some 
operations performed with v5.1.2 of the Macintosh client software would take much longer 
than with previous versions of the client software. This problem has been fixed in v5.1.3.

➤ The client installer for clients running the Windows 64-bit Storage Server 2003 operating 
system was missing some files. The Windows 64-bit Storage Server 2003 installer now 
includes all the required files.

➤ The Final Cut Pro application had been slow when switching between the Finder and back to 
the Final Cut Pro application. The delay depended on size of project; the larger the project, 
the longer the delay. Avid has made changes in the Avid Unity client software that address 
unused calls made by the Final Cut Pro application, and the connection with Avid Unity. 

http://www.avid.com/onlinesupport
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New in Version 5.1.2

Avid Unity MediaNetwork v5.1.2 is a Windows client and Macintosh client software 
release, and does not include server software. You do not need to update the server and 
network infrastructure. These client software updates are only available on the Avid 
Download Center. Avid Unity MediaNetwork v5.1.2 client software is supported in v5.1.1, 
v4.2.4, and v4.1.6 infrastructures. The following changes were made:

• Windows client software — adds support for the Windows Server 2003 64-bit 
operating system. This Windows client installer can be used for all Windows clients. 
This Windows client release is required if adding a server with a Windows Server 2003 
64-bit operating system to your v5.1.1, v4.2.4, or v4.1.6 infrastructure. This release also 
improves delays on Windows Vista clients when opening files over the shared storage 
network. There is no reason to upgrade your Windows XP v5.1.1 clients to v 5.1.2.

• Macintosh client software — includes the fixes listed in “Fixed in Version 5.1.2” on 
page 9.

Final Cut Pro Software Approved

Avid has tested Final Cut Pro as a client in the Avid Unity MediaNetwork shared storage 
environment. Testing was done with Avid Unity MediaNetwork v5.1.2 client software in the 
v5.1.1 server infrastructure with Final Cut Pro v6.0.4 and v6.0.5. (Final Cut Pro is not 
supported in the Avid Unity MediaNetwork v4.2.4 and v4.1.6 server infrastructures.) There 
is no Avid restriction on the QuickTime version. Use the QuickTime version recommenced 
in the Final Cut Pro application. QuickTime v7.6 was the version used in the Avid testing. 
For information on how many streams were qualified per client at various resolutions, see 
the Avid Unity MediaNetwork v5.1 Performance Guide on the Knowledge Base at 
www.avid.com/onlinesupport/. 

n Avid Interplay Access supports the Mac OSX platform, and through this application Final 
Cut Pro QuickTime files and projects can be checked into Interplay. Any Interplay 
workstation can search for these files and edit their Interplay metadata, though there is 
currently no tightly integrated workflow between Avid editors and Final Cut Pro within 
Interplay. 

The following list characterizes the setup guidelines for your Final Cut Pro client with Avid 
Unity MediaNetwork: 

• You need to stay in line with the general client parameters specified for all Avid Unity 
MediaNetwork Macintosh clients. The following are the specific hardware details used 
in the Avid testing:

- Platforms — Mac Pro (early 2008) “Harpertown” Dual Quad-Core 3.0 or 3.2 GHz.

- Operating system — Mac OS 10.5.4 and later.

http://www.avid.com/onlinesupport
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- Avid Unity MediaNetwork — Fibre Channel connection using the ATTO Celerity 
FC-41ES adapter board (Avid has not tested Final Cut Pro as an Ethernet client on 
Avid Unity MediaNetwork and is not supported at this time).

• Final Cut Pro editing software was characterized with the AJA KONA™3 hardware. The 
complete Apple Studio 2 bundle was installed.

• Verification tests on Apple Color and Sound Track Pro were run to verify Push - Pull 
capabilities.

• Final Cut Pro media should be in its own Allocation Group. Including:

- Scratch disks

- Project files

c Do not mix Final Cut Pro clients and Avid editor clients within the same Allocation 
Group.

• Final Cut Pro editing systems require 30% to 50% more bandwidth than Avid Media 
Composer at similar resolutions.

• The number of Final Cut Pro clients supported in an Allocation Group are about 1/2 the 
number of Avid Media Composer clients at similar resolutions.

n Make sure the workspaces you are using is part of the Allocation Group you created for 
Final Cut Pro clients. When Final Cut Pro clients are sharing the same Allocation Group as 
Avid editing clients, the Final Cut Pro clients have poor performance.

• Digidesign Pro Tools software was not tested with Final Cut Pro clients.

Fixed in Version 5.1.2

Avid Unity MediaNetwork v5.1.2 includes the following Macintosh client fixes: 

➤ Macintosh fiber clients occasional disconnected and would reconnect 30 seconds later. This 
disconnect issue has been resolved in v5.1.2.

➤ When JKL scrubbing or fast scrubbing on the timeline with Macintosh Ethernet clients, the 
client would get a very slow response causing the Macintosh “beach ball” to display and 
eventually an “Exception: AECIFS_ERROR.” The JKL scrubbing and fast scrubbing on the 
timeline no longer cause the slow response, the Macintosh “beach ball,” or “Exception: 
AECIFS_ERROR.”

➤ Some files that were tagged for deletion on Macintosh clients were being left behind in the 
folder (for example ~avid_removed~xxx). All files that are tagged for deletion are now gone 
from the folder after the delete function has completed.
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➤ When using Final Cut Pro® there was a problem where the link to media for partially 
rendered effects was lost. This is fixed in the v5.1.2 of the Macintosh client software.

➤ Windows Vista clients no longer have delays when opening files over the shared storage 
network.

New in Version 5.1.1
The following sections describe the changes and new features in Avid Unity 
MediaNetwork v5.1.1. This release is a full server and client software update. The 
Avid Unity MediaNetwork v5.1.1 client software is also supported in the v4.2.4 and v4.1.6 
infrastructures.

Preferred Drive Letter Mapping

Avid Unity MediaNetwork v5.1.1 has a new Connection Manager feature for Windows 
clients called Preferred Drive Letter Mapping. Preferred Drive Letter Mapping allows you to 
specify the drive letter for a mounted workspace. This feature is not available in the Avid 
Unity MediaNetwork user interface. After you install the Client Manager software on your 
client you must edit a text file that is created and saved in the local settings of the Windows 
client system.

The Preferred Drive Letter Mapping file does not affect the decision of what workspace to 
mount. When you mount a workspace the software checks the Preferred Drive Letter 
Mapping file to see if there is a preferred drive letter. If you have edited the Preferred Drive 
Letter Mapping file, workspaces with a Preferred Drive Letter Mappings are processed 
before those that don’t have preferred drive letters. Workspaces with no Preferred Drive 
Letter assignment use other available drive letters.

If a Preferred Drive Letter is already mapped to another drive (for example, a USB drive), 
the workspace uses a different available drive letter. 

To use the feature:

1. Log out the Connection Manager.

2. Open your Notepad application and create a new file (File > New). 

3. Enter the <device name> and <workspace name> as shown in the following example:

F: \\path\workspace1

Q: \\path\workspace2

n The <device name> can be “F” or “F:” or “F:\” and the workspace name cannot contain 
spaces. 
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4. Save the text file as “AvidPDL.txt” on the client system in the following location 
depending on your operating system:

Windows XP

C:\Documents and Settings\user_name\Local Settings\Application Data

Windows Vista

C:\Users\user_name\AppData\Local

5. Start the Connection Manager and select the workspace. The file is read every time you 
mount a workspace. 

Fixed in Version 5.1.1

Avid Unity MediaNetwork v5.1.1 includes the following fixes: 

➤ Macintosh clients were randomly experience kernel panics during some audio functions 
between the client and the workspace, these audio functions no longer trigger a kernel panic.

➤ When Macintosh Ethernet clients saved bins that had 110 characters or more in the path 
name, the file name, or combination of the path and file names; the media engine would 
occasionally stop functioning (to a Windows blue screen). The code causing this behavior 
has been corrected.

➤ While in the shared project if there were 16 or more bins open, a bin folder would sometime 
become invisible to the project and Apple Finder. Bins no longer disappear from your 
project when more that 15 bins are open. 

➤ Some workspace data was left in the operating system of Macintosh clients when 
workspaces were unmounted. All folder information is now complete removed from the 
client when workspaces are unmounted.

➤ When a workspace is named the same as an external drive and both are mounted on a 
Macintosh client, data from external drive was hidden. Now both the external drive and 
workspace can be viewed at the same time.

➤ When Interplay Instinct sent a playlist to a playback device, the player would remain in a 
Loading state. Now when Interplay Instinct sends a playlist to the playback device, the 
playback device plays out the list successfully.
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New in Version 5.1
The following sections describe the changes and new features in Avid Unity 
MediaNetwork v5.1. This release adds Macintosh Leopard and Windows Vista clients to the 
Avid Unity MediaNetwork environment. 

Client Support with Various MediaNetwork Environments
Avid Unity MediaNetwork v5.1 client software can now be used in earlier MediaNetwork 
environments. If you have a MediaNetwork v4.1.6 or v4.2.4 infrastructure running the 
appropriate MediaNetwork server software, you can now run MediaNetwork v5.1 client 
software on your Windows XP and Macintosh (10.4.11) clients. Windows Vista and 
Macintosh Leopard (10.5.3 and later) clients with MediaNetwork v5.1 client software can 
also be used in MediaNetwork v4.1.6 or v4.2.4 environments.

Support for 1 TB Drives
Avid Unity MediaNetwork v 5.1 now supports 1 terabyte (TB) drives in the media engine 
and MEDIArray drive enclosures. To support 1 TB drives you need to increase the memory 
(RAM) in the media engine from 2 GB to 4 GB. New media engines shipped with Avid 
Unity MediaNetwork v5.1 and later comes with 4 GB of RAM.

Support for Eight Drive Enclosures
Avid Unity MediaNetwork v5.0.x supports five drive enclosures (the media engine and four 
MEDIArray XT drive enclosures). Avid Unity MediaNetwork v5.1 and later supports eight 
enclosures (the media engine and seven drive enclosures). Additional drive enclosures can 
be a combination of MEDIArray XT and MEDIArray LP enclosures. To support six or more 
drive enclosures you need to increase the RAM in the media engine from 2 GB to 4 GB. 
New media engines shipped with Avid Unity MediaNetwork v5.1 and later come with 4 GB 
of RAM.

When adding MEDIArray drive enclosures, you must connect them directly to a 
MEDIASwitch. Remember to change the switch configuration if necessary. For information 
on connecting the MEDIArray drive enclosures, see the Avid Unity Media Engine and Avid 
MEDIArray XT Setup Guide. The setup guide does not list the MEDIArray LP but the 
process is the same. For a change when using two MEDIASwitch. see “Connecting Multiple 
Avid MEDIArray Enclosures to Two MEDIASwitches” on page 13. 

To use a MEDIArray LP in your Avid Unity MediaNetwork v5.x environment:

• The MEDIArray LP shipped with an ATTO CTFC-41XS adapter board installed in 
PCI-X slot 3, that is the supported configuration when connecting the MEDIArray LP in 
the MediaNetwork v5.x environment. The optional second Fiber Channel board in 
PCI-X slot 2 is not supported. 

If you have the optional second Fibre Channel board installed, you can either remove it 
or leave it installed, but do not use it for any fiber connection.
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• Install the Avid MEDIArray software on the MEDIArray LP using the Avid Unity 
MediaNetwork v5.1.x DVD-ROM.

c If you are moving a MEDIArray LP enclosure from an existing Avid Unity 
MediaNetwork system to a v5.x, you must uninstall the existing MediaNetwork 
software (IBOD) and install the v5.x MediaNetwork software from the installer DVD. 
Failure to do so can result in total data loss.

• Load the ATTO Fibre Channel driver qualified for Avid Unity MediaNetwork v5.1.x.

Connecting Multiple Avid MEDIArray Enclosures to Two MEDIASwitches

This section replaces the “Connecting Multiple Avid MEDIArray Enclosures to Two 
MEDIASwitches” section in the Avid Unity Media Engine and Avid MEDIArray XT Setup 
Guide. Now that Avid Unity MediaNetwork v5.1 supports up to seven Avid MEDIArray 
drive enclosures (any combination of Avid MEDIArray XTs and Avid MEDIArray LPs), the 
following configuration is required when you have two MEDIAswitches and up to seven 
optional storage enclosures. 

The first Avid MEDIArray enclosure connects to Port 15 of the MEDIASwitch 2. The 
second Avid MEDIArray enclosure connects to Port 15 of the MEDIASwitch 1. The third 
storage enclosure use port 14 on the MEDIASwitch 2 and fourth storage enclosure uses port 
14 on the MEDIASwitch 1. As you add more Avid MEDIArray enclosures continue 
alternating the enclosures between the Avid MEDIASwitches as shown in the figure.

Adding Seven Avid MEDIArray Enclosures — to Two MEDIASwitches

a

a

MEDIASwitch 1

MEDIASwitch 2

Avid Unity 
Media Engine

LC to LC connection

Port 15 Avid MEDIArray XT/LP 1
Port 14 Avid MEDIArray XT/LP 3
Port 13 Avid MEDIArray XT/LP 5
Port 12 Avid MEDIArray XT/LP 7

Port 13 Avid MEDIArray XT/LP 6
Port 14 Avid MEDIArray XT/LP 4
Port 15 Avid MEDIArray XT/LP 2
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Bandwidth Improvements

Avid Unity MediaNetwork v5.1 provides better client bandwidth allowing a greater number 
of clients to work with higher resolutions. For information on how many streams were 
qualified per client at various resolutions, see the Avid MediaNetwork v5.1 Performance 
Guide on the Knowledge Base. 

Macintosh Leopard

Avid Unity MediaNetwork v5.1 now supports clients that use Macintosh Leopard operating 
systems (Mac OS version 10.5.3 and later). The following is a list of Leopard changes you 
need to know when working in the Avid Unity MediaNetwork environment and installing 
the client software on your Leopard clients.

This release supports Macintosh 10.4.11 and 10.5.3 and later operating systems. When 
updating your Macintosh clients select the appropriate installer for your fiber or Ethernet 
client. 

Workspaces on Desktop

Mounted MediaNetwork workspaces no longer appear on the desktop by default. Connected 
servers are disabled by default on Leopard. As a result, MediaNetwork workspaces do not 
automatically appear on the desktop when mounted as they did in earlier versions of the 
Mac OS.

To enable workspaces to appear on the desktop in Leopard:

1. Navigate to Finder > Preferences.

2. Select General.

3. Select “Connected servers” checkbox under “Show these items on the Desktop.”

Any currently mounted MediaNetwork workspaces now appear on the desktop.

4. Disable Connected servers by deselecting the Connected servers checkbox.

Workspaces Visible in the Finder

Mounted MediaNetwork workspaces are no longer readily visible in the Finder in Leopard 
clients. The following instructions describe how to view mounted workspaces by enabling 
Computer in the Finder. When Computer is disabled in the Finder, mounted workspaces are 
not available on the desktop.

To view mounted workspaces if Computer is Disabled In the Finder:

1. Navigate to Finder > Preferences.

2. Select Sidebar.
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3. Select Computer checkbox under Devices. 

4. Click on Devices in the Finder. Devices is enabled by default.

5. Click the name of the drive.

6.  Control-click the icon at the top of the Finder.

7.  Select the folder name of the computer and then the workspaces appear in the Finder.

To Enable Computer in the Sidebar of the Finder and View Mounted Workspaces:

1. Navigate to Finder > Preferences.

2. Select Sidebar.

3. Select Computer checkbox under Devices. After Computer is selected, the name of the 
computer appears under the Devices list in the Finder.

4. Select the name of the computer in the Finder and the workspaces will now appear. 
Workspaces will now appear when a user selects the name of the computer.

Disable Computer in the Sidebar by deselecting the Computer checkbox under Devices.

Windows Vista

Avid Unity MediaNetwork v5.1 now supports clients that use Windows Vista operating 
systems with Service Pack 1. 

ATTO Configuration for Windows Vista Fiber Channel Clients

If you are connecting a Windows Vista Fiber Channel client, you must manually configure 
the Interrupt Coalesce setting to None.

To set the Interrupt Coalesce setting:

1. Copy the ATTO Configuration Tool from the Avid Unity MediaNetwork v5.1.x installer 
kit to the Avid Unity Fibre Channel client and install the tool. The ATTO Configuration 
Tool installer is located in the following location:

Drivers_Firmware\HostBusAdapters\ATTO\Utilities\Windows\3.14\win_app
_configtool_314.exe

2. Double-click the installer file (win_app_configtool_314.exe), the tool installs on local 
drive.

3. Click Start > All Programs > ATTO Configuration Tool and select Configuration Tool. 

The ATTO Configuration tool opens.

4. In the Device Listing window, expand the localhost > CelerityFC-xxxx > Channel x 
(navigate to the appropriate channel on your host adapter).

5. In the right pane, click the NVRAM Configuration tab.
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6. Click the Interrupt Coalesce menu, and select None.

7. Click Commit.

8. Restart your computer for the change to take effect.

Enabling the Distributed File System on Windows Vista

Avid disables the Windows Vista Distributed File System (DFS) in the Avid Unity 
MediaNetwork clients. Avid Unity MediaNetwork clients running Windows Vista might 
have delays when opening files over the shared storage network with DFS enabled. If you 
need to run DFS on your Windows Vista client, use the following procedure to enable the 
DFS by changing a registry key.

To add the registry key:

1. Select the Windows Vista Run program.

2. Type Regedit to enter the Registry Editor application.

3. Browse to the following location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Mup

4. Right-click the new DisableDfs entry and select Modify.

5. Do one of the following:

a. Type 0 in the Value data text box to enable DFS and click OK.

b. Type 1 in the Value data text box to disable DFS and click OK (default setting).

6. Close the Registry Editor windows and restart the system.
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Connection Manager Configuration

When you right-click on the Connection Manager icon in the task bar, you might notice that 
the Configure menu selection is not selectable. In earlier releases, standard users could select 
and open the Configuration window, but could not make changes. Configuration changes 
still need administrative privileges, but in this release the Configuration menu selection is 
only selectable when you are an Administrative user.

ATTO Configuration Mode Settings

The following sections described the Connection Mode settings in the ATTO Configuration 
Tool with Avid Unity MediaNetwork v5.1.x. For changes when using that Windows Vista 
clients, see “ATTO Configuration for Windows Vista Fiber Channel Clients” on page 15.

ATTO Configuration in 2 Gb Unity (not LANshare) Environments

If you are connecting a Fiber Channel client using a supported ATTO Celerity board to a 
2-Gb Vixel switch running Avid Unity MediaNetwork v4.16, you must manually configure 
the connection mode on the client to AL (Arbitrated Loop). This setting is required for 
connecting 4-Gb clients to a 2-Gb Vixel fiber switch while running Avid Unity 
MediaNetwork v5.1.x client software. 

To set the Connection Mode setting:

1. Copy the ATTO Configuration Tool from the Avid Unity MediaNetwork v5.1.x installer 
kit to the Avid Unity Fibre Channel client and install the tool. The ATTO Configuration 
Tool installer is located in the following location:

- (Windows) [Installer DVD or download package]:\Drivers_Firmware\
HostBusAdapters\ATTO\Utilities\Windows\3.14\win_app_config
tool_314.exe

- (Macintosh) [Installer DVD or download package]:Drivers_Firmware_Mac\
HostBusAdapters\ATTO\Utilities\OSX\3.16\osx_app_configtool

_316.dmg

2. Double-click the installer file, the tool installs on local hard drive.

3. Do one of the following:

- (Windows) Click the Start button, and select Programs > ATTO Configuration Tool 
> Configuration Tool. 

- (Macintosh) Navigate to the Applications folder and then double-click ATTO 
Configuration. 

The ATTO Configuration tool opens.
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4. In the Device Listing window, navigate to the appropriate channel on your host adapter.

The NVRAM Configuration tab opens.

5. Click the Connection Mode menu, and select AL (Arbitrated Loop).

6. Click Commit.

7. Restart your computer for the change to take effect.

LANshare Fibre Channel Connection to the Client

If you are directly connecting a Fiber Channel client using a supported ATTO Celerity board 
to a 4 Gb LANshare LP running Avid Unity MediaNetwork v4.2.4, a 4 Gb LANshare EX 
running Avid Unity MediaNetwork v4.2.4, or to a 2 Gb LANshare EX running Avid Unity 
MediaNetwork v4.16, you must manually configure the connection mode on the client with 
the FC-41EL to Point-to-Point (PTP). This setting is required for connecting 4 Gb clients to 
a 2 Gb or 4 Gb LANshare server while running Avid Unity MediaNetwork v5.1.x client 
software.

n When using any other Celerity ATTO Fiber Channel adapter, see the ATTO configuration 
limitation during upgrades page 51.

Connecting to the LANshare environment in Avid Unity MediaNetwork v4.x is possible 
because the Avid Unity MediaNetwork v5.1.x client software allows connections to earlier 
Avid Unity MediaNetwork v4.x servers.

To reset the Connection Mode setting:

1. Copy the ATTO Configuration Tool from the Avid Unity MediaNetwork v5.1.x installer 
kit to the Avid Unity Fibre Channel client and install the tool. The ATTO Configuration 
Tool installer is located in the following location:

- (Windows) [Installer DVD or download package]:\Drivers_Firmware\
HostBusAdapters\ATTO\Utilities\Windows\3.14\win_app_config

tool_314.exe

- (Macintosh) [Installer DVD or download package]:Drivers_Firmware_Mac\
HostBusAdapters\ATTO\Utilities\OSX\3.16\osx_app_configtool
_316.dmg

2. Double-click the installer file, the tool installs on local hard drive.
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3. Do one of the following:

- (Windows) Click the Start button, and select Programs > ATTO Configuration Tool 
> Configuration Tool. 

- (Macintosh) Navigate to the Applications folder and then double-click ATTO 
Configuration. 

The ATTO Configuration tool opens.

4. In the Device Listing window, navigate to the appropriate channel on your host adapter.

The NVRAM Configuration tab opens.

5. Click the Connection Mode menu, and select Point-to-Point (PTP).

6. Click Commit.

7. Restart your computer for the change to take effect.

Qlogic Fibre Channel Connection to the Client

If you are connecting a Fiber Channel client using an Celerity adapter board to a Avid Unity 
MediaNetwork infrastructure running Avid Unity MediaNetwork v4.16, v4.24, or v5.1.x on 
a 4 Gb Qlogic switch, you should set the board to PTP preferred mode. This setting is 
common on sites that already have configured clients. For instruction on setting the mode, 
see “LANshare Fibre Channel Connection to the Client” on page 18. 

Fixed in Version 5.1

➤ You no longer need to “Disable NetBIOS over TCP/IP” in the NetBIOS setting panel to fix a 
long delay before your workspace appears after you restarted a client and map a workspace 
for the first time.

➤ The unexplained “Mac-36” error that you might have experienced when dragging files to the 
workspaces no longer appears. You now get an “out of disk space” message when the 
workspace is running low on free space. 

Even if you see that the workspace has enough space available for the files you intend on 
copying, you must allow additional space for overhead requirements. The Avid Unity 
MediaNetwork software uses 256 MB of temporary transient space per file copied, for a 
significant number of seconds before releasing the space and returning it to actual free space 
for the file manager. Avid recommends you have a minimum of 50 GB of space when 
copying files. In some cases, even more might be required.
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New in Version 5.0.2

Avid Unity MediaNetwork v5.0.2 is for Macintosh clients only and requires an Avid Unity 
MediaNetwork v5.0.1 or later infrastructure. This release does not include server software. 
Avid Unity MediaNetwork v5.0.2 includes the following fix:

➤ There was a condition when attempting to create or save MXF media to a workspace that 
caused a Macintosh kernel panic error in Macintosh clients. A fix was implemented to 
prevent the kernel panic

New in Version 5.0.1

Changes were made in the Avid Unity MediaNetwork software protocol that prevents earlier 
versions of Avid Unity MediaNetwork clients from connecting to the server. Only 
Avid Unity MediaNetwork v5.0.1 and later clients are supported on Avid Unity 
MediaNetwork v5.0.1. 

n If you have Avid Unity MediaNetwork clients using software version v5.0 or earlier, you 
need to update the client software before those clients can connect to Avid Unity 
MediaNetwork v5.0.1.

Avid Unity MediaNetwork v5.0.1 includes the following fixes: 

➤ Previously, Macintosh clients that were editing and saving sequences to a shared bin would 
stop responding. This issue has been corrected. 

➤ Macintosh clients no longer stop responding when attempting to unmount workspaces using 
the Avid Unity MediaNetwork Fiber Manager or Apple Finder.

➤ Your Macintosh editing application no longer stops responding when exporting an AAF 
(format) clip at 1:1 (resolution) from an Avid Unity MediaNetwork workspace.

➤ The Windows 2003 server operating system running on the Avid Interplay Engine no longer 
stops responding when stopping and restarting File Manager. For example if you needed to 
stop the File Manager for maintenance, it no longer affects the Avid Interplay Engine 
operating system. 

➤ Updates were made in Avid Unity MediaNetwork v5.0.1 to allow Final Cut Pro v6.0 and 
v5.1.x project files to be saved to Avid Unity workspaces. Previously, an error message 
would display when attempting to save Final Cut Pro project files to Avid Unity 
MediaNetwork v5.0.
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➤ Previously the first Ethernet client to mount a workspace caused other clients to receive 
“Access Denied” error messages when trying to write to that workspace. This condition only 
happened when “Enable dynamic mounting of MediaNetwork workspaces” was selected. 
(This setting is in the Avid Media Engine.) Now multiple users can write to the same 
workspace without receiving Access Denied messages regardless if using dynamic or static 
mounting. 

New in Version 5.0

Avid Unity MediaNetwork v5.0 introduced new server and storage hardware that provides 
higher performance while reducing the system components needed in previous 
MediaNetwork releases. The following highlights the component changes: 

• Avid Unity Media Engine is the Ethernet server, designed to use the built-in Ethernet 
ports. One Ethernet client can connect directly into the Avid Unity Media Engine or the 
port can be used to connect Ethernet switches supporting up to 20 Ethernet clients. 

This model does not include a Fibre Channel adapter board but it can be purchased 
separately as an option to give the Avid Unity Media Engine, Fibre Channel capabilities. 
You must purchase the Fibre Channel adapter board and a Fibre Channel switch to add 
optional Avid MEDIArray XT storage. Up to 26 Fibre Channel clients are supported 
through the Fibre Channel switch. 

• Avid MEDIArray XT is a drive enclosure with a Fibre Channel connection used to 
connect to a Fibre Channel switch. Up to four Avid MEDIArray XT drive enclosures 
can be added to a Avid Unity Media Engine.
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Hardware and Software Requirements
Avid Unity MediaNetwork v5.0.1 does not support any earlier versions of MediaNetwork 
software. You must have Avid Unity MediaNetwork v5.0.1 or later to use v5.x hardware.

Supported Hardware

The following table lists the hardware that is supported in the Avid Unity MediaNetwork 
v5.x environment and which HBA is required. When installing the ATTO Fibre Channel 
board, see “ATTO Board Slot Location” on page 26 for slot information.

 
Supported Hardware  

Hardware Host Bus Adapter

Server and Operating System

Avid Unity Media Engine, 
Windows 2003 Server

Optional ATTO CTFC-41XS

Storage

Avid MEDIArray XT,
Windows XP Pro

ATTO CTFC-41XS
ATTO CTFC-42XS

Avid MEDIArray LP, 
Windows XP Pro

ATTO CTFC-41XS

Editor Platforms

HP® xw9300 (Avid DS Nitris only) ATTO® CTFC-41XS

HP xw8600 ATTO CTFC-41ES
ATTO CTFC-41EL

Intel® Pro 1000 PT

HP xw8400

n Requires four 1-GB DIMMs of RAM in 
the HP xw8400 workstation.

ATTO CTFC-41ES
ATTO CTFC-41EL

HP xw8400 (Avid DS Nitris only) ATTO CTFC-41XS

HP xw8200 ATTO CTFC-41XS

HP xw8000 ATTO CTFC-41XS

Mac Pro with OS X ATTO CTFC-41ES (PCI-E)

Mac G5 with OS X ATTO CTFC-41ES (PCI-E)
ATTO CTFC-41XS (PCI-X)
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HP Z800, Z400, and xw8600 Workstations
The HP® Z800 and Z400 workstations are now qualified platforms for the Avid editing 
system. The built-in network ports in the Z800 and Z400 workstations can be used for 
Ethernet connections to the Avid Unity MediaNetwork infrastructure.

The built-in network ports in the xw8600 workstation can be used for Ethernet connections 
to the Avid Unity MediaNetwork infrastructure except when using a Windows Vista, 64-bit 
client connected to an Avid Adrenaline™. The Windows Vista, 64-bit client with an 
Avid Adrenaline requires that you use the Intel® Pro 1000 PT for your Ethernet connection.

Unsupported Hardware
The following hardware components are not supported in the Avid Unity 
MediaNetwork v5.x environment:

• 2 GB switches

• 2 GB storage

• 2 GB MEDIArray enclosures

Interplay Server Platforms n For details, see the Avid Interplay™ Software 
Installation and Configuration Guide.

SR2400 and SR2500 (Windows XP) ATTO CTFC-41XS (top slot, 3)

SR2400 and SR2500 (Windows 2003 Server) ATTO CTFC-41XS (top slot, 3)

Ethernet Switches

Asante® 35160-T —

Cisco® 3560G-24TS —

Cisco 3750G-24TS —

SMC 8824 —

Fibre Switch

MEDIASwitch 16-4Gb (4 gigabit) QLogic® 5602 16-port 4 Gb FC switch
You can stack a second switch using the 10-Gb link.

MEDIASwitch 10-4Gb (4 gigabit) QLogic 1404 10 port 4 Gb FC switch

Supported Hardware (Continued)  

Hardware Host Bus Adapter
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Fibre Channel ATTO 41EL Adapter Board
This section provides ATTO CTFC-41EL Fibre Channel adapter board restrictions when 
used in Avid Unity MediaNetwork v5.1.x clients. This board should only be installed in 
software-only editing clients, Avid Mojo clients, and Avid Adrenaline clients. Do not use the 
board ATTO CTFC-41EL Fibre Channel adapter board in the following configurations:

• Avid Symphony Nitris

• Avid Nitris DX

• Avid Mojo DX

• Macintosh Pro clients

Supported Software

The following tables list the operating systems and Avid client software that are supported in 
Avid Unity MediaNetwork v5.x.

Supported Software Editor Operating Systems and Service Packs  

Software Version

Windows® Vista (32 and 64 bit) Service Pack 1

Windows XP (32 and 64 bit) Service Pack 2

Windows 2003 Server (32 bit) Service Pack 2

Mac OS X 10.4.11 and 10.5.3 and later

Editing Client Requirements for Avid Unity MediaNetwork v5.1.x  

Software Release Number Required Hardware

Media Composer® v2.8.x and later Dual Processor HP xw8000, HP xw8200, HP xw8400, or 
HP xw8600

Macintosh G5, Mac Pro, and Dual Quad-Core Mac Pro 
systems (8-core processing)

Avid Instinct® v1.2.x and later Workgroup Environment

Avid Interplay® v1.2.x and later SR2400
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Avid Symphony™ Nitris® v1.8.x and later Dual Processor HP xw8200, HP xw9300, or Dual 
Quad-Core Processor HP xw8400

Avid DS Nitris® v8.4 and later Dual Quad-Core Processor HP xw8400

For the most up to date information, see the Product 
Information listing at: http://www.softimage.com/avidds

NewsCutter® and 
NewsCutter XP

v6.8.x and later Dual Processor HP xw8000, HP xw8200, HP xw8400, or 
HP xw8600

AirSpeed® v2.1 and later

AirSpeed Multi Stream v1.0 and later

Digidesign Pro Tools HD v7.4 and v8.0 Windows — Real-time support is based on the number of 
clients, drives, sample rate, and edit density.

For the most up to date information, search for 
MediaNetwork at: http://www.digidesign.com

Macintosh — No real-time support (push/pull only)

Editing Client Requirements for Avid Unity MediaNetwork v5.1.x (Continued)  

Software Release Number Required Hardware

http://www.softimage.com/avidds
http://www.digidesign.com/
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ATTO Board Slot Location

The following illustration identifies the ATTO board slot for the Windows platforms.

• HP Z800, HP Z400

• HP xw8600, HP xw8400, HP xw8200, HP xw8000

• HP xw9300

Slot Locations for ATTO Celerity in Supported Windows Computers

 In
1/A

Out
1/A

Out
2/B

 In
2/B

Base

Codec

xw8400

xw8400 xw8600 and xw8200
Symphony Nitris, Adrenaline, Mojo, Mojo SDI, Mojo DX, and Nitris DX

xw8000

 In
1/A

Out
1/A

Out
2/B

 In
2/B

Base

Codec

ATTO Celerity board or Intel Pro 
1000 PT in xw8600 with Windows 
Vista 64 and Adrenaline)

ATTO Celerity board
100 MHz Slot

xw9300
DS Nitris and Dual-Boot Nitris 

ATTO Celerity board
PCI-E x8 (x4) Slot

ATTO Celerity 
board

Z400

ATTO Celerity board Slot

Z800
Mojo SDI, Mojo DX, and Nitris DX
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The following illustration identifies the ATTO board slot for the Macintosh platforms.

• Avid supported Macintosh Pro running OS X 10.4.11 or 10.5.3 and later

• Avid supported Macintosh G5 running OS X 10.4.11 or 10.5.3 and later

Slot Locations for ATTO Celerity in Supported Macintosh Computers

Mac Pro Models

Mac Pro models with Intel® Harpertown and Intel Xeon® Nehalem processors have been 
qualified. Avid feels the best way to identify your model is to use the following procedure:

To identify your Mac Pro model:

1. Click the Apple icon and select About This Mac.

2. Click the More Info button in the About This Mac window.

3. In the Hardware Overview, note the Model Identifier:

- MacPro 1,1 and MacPro 2,1 — original models

- MacPro 3,1 — Intel Harpertown, Early 2008 model

- MacPro 4,1 — Intel Xeon® Nehalem model

ATTO Celerity board

Macintosh G5 Macintosh Pro

ATTO Celerity board slot for Mac Pro 
models with Harpertown and 
Nehalem processors
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Fibre Channel Adapter Board Firmware and Drivers

The following table lists the revisions of supported firmware and driver needed for Fibre 
Channel boards on servers and storage for Avid Unity MediaNetwork v5.x. To load 
Firmware and drivers, see “Loading Fibre Channel Firmware and Drivers” on page 40.

n Avid ships the media engine with the scsiport driver. The scsiport driver is also loaded if you 
reimage the media engine. You only would need to change the setting if you ran the ATTO 
v2.61 utility on the media engine.

The ATTO v2.61 driver utility automatically selects the scsiport or storport driver for your 
client. If you install the ATTO v2.61 driver on the Windows 2003 operating system, the 
utility installs the storport driver. This is the correct driver for a Windows 2003 client, but 
not the driver that is qualified on the media engine. The following procedure describes how 
to reinstall the scsiport driver on the media engine. 

ATTO Fibre Channel Adapter Boards Firmware and Driver Versions  

ATTO Celerity Family

Platform Firmware Version Driver

Avid Unity Media Engine
(ATTO Fibre Channel board optional)

December 8, 2006, v2.5 v2.61 scsiport

Avid MEDIArray XT — (optional storage, ships with 
ATTO Fibre Channel board installed)

December 8, 2006, v2.5 v2.61 scsiport

Avid MEDIArray LP — (optional storage supported in 
Avid Unity MediaNetwork v4.2.x environments)

December 8, 2006, v2.5 v2.61 scsiport

Windows 2003 clients December 8, 2006, v2.5 v2.61 storport

Windows XP 32-bit clients December 8, 2006, v2.5 v2.61 scsiport

Windows XP 64-bit clients December 8, 2006, v2.5 v2.61 storport

Windows Vista 32-bit and 64-bit clients December 8, 2006, v2.5 v2.61 storport

Mac clients

OS X 10.4.11
OS X 10.5.3 and later

December 8, 2006, v2.5
December 8, 2006, v2.5

v3.2.1
v3.2.1

N/A
N/A
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To check or change the storport driver to the scsiport driver on the Avid Unity Media 
Engine:

1. Navigate to C:\windows\system32\drivers\ on the media engine.

2. Right-click the ClrtyFC.sys driver and select Properties.

3. Click the Version tab.

Under the Description, it should say “Celerity HBA Windows x86 scsiport driver.”

4. If the description says storport then rename the ClrtyFC.sys file to ClrtyFC.storport.

5. Copy the scsiport version of ClrtyFC.sys file from the Avid Unity MediaNetwork DVD 
to the C:\windows\system32\drivers folder. The location of the scsiport ClrtyFC.sys file 
on the DVD is:

[DVD drive]:\Drivers_Firmware\HostBusAdapters\ATTO\Drivers\Windows\
Celerity\2.61\32bit\

6. Restart the media engine.

Windows XP Firewall

If you install Windows XP SP2 on an Avid Unity client system, make sure to do the following:

1. Start the Security Center application from Start > All Programs > Accessories > System 
Tools > Security Center.

2. Click Windows Firewall.

3. In the General tab, make sure Firewall is turned ON.

4. In the Exceptions tab, make sure the Avid Unity Connection Manager is listed in the 
exceptions list and has a check mark next to it.

5. In the Exceptions tab, make sure the Avid Unity Connection Manager is listed in the 
exceptions list and has a check mark next to it.

6. In the Advanced tab, navigate to the ICMP area and click the Settings button.

7. Make sure “Allow incoming echo requests” has a check mark next to it.

8. In the main Security Center window, click Automatic Update. Make sure the “Turn off 
Automatic Windows Updates” is selected.

Using the Avid Unity MediaNetwork Help on the Macintosh

When you are using the search feature in the Avid Unity MediaNetwork Help, a bug exists if 
Safari is your default browser. You might experience issues when performing searches. You 
need to empty the Safari cache in between searches (Select Safari > Empty Cache.) This 
search issue does not occur when using Firefox as your browser.
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Avid Unity Media Engine

The Avid Unity Media Engine is a PC-compatible system that runs the Windows 2003 server 
operating system with Service Pack 1. The Avid Unity Media Engine system must be 
dedicated to service only Avid Unity workgroups. Install only the Avid Unity workgroup 
software and other Avid-authorized software on the system. 

When you purchase the optional Fibre Channel board, up to 26 Fibre Channel clients and up 
to eight Avid MEDIArray drive enclosures through a Fibre Channel switch. The Avid Unity 
Media Engine connects up to 20 Ethernet clients using the built in gigabit Ethernet board 
which is connected to an Ethernet switch. An optional Fibre Channel adapter board is 
available for connecting additional storage and Fibre Channel clients.

Media Engine and Avid MEDIArray Slot Locations on the Rear Panel

The following table lists the standard and optional boards that are supported in the 
Avid Unity Media Engine PCI slots. 

Serial connector

Power 
supply 
modules

Mouse (top)

Keyboard (bottom)

USB connectors

Alarm Reset button
Optional Fibre Channel adapter in 
the Avid Unity Media Engine

PCI slots

VGA monitor connector

2 Gigabit Ethernet ports

7 1

Supported Slot Configuration  

PCI Slot Interface Description

1 – 5 PCI, 32-bit None These slots are not used. No optional adapter boards are 
supported.



Avid Unity Media Engine

31

The Fibre Channel adapter boards are not installed in the Avid Unity Media Engine when it 
ships — you should install them according to the previous table. For more information, see 
the Avid Unity Media Engine Setup Guide. For more information on the Fibre Channel 
adapter, see “Fibre Channel Adapter Board Firmware and Drivers” on page 28. 

Memory Configuration

Avid Unity MediaNetwork v 5.1 now ships with two 2-GB modules installed for a total of 
4 GB of memory in the media engine. 

Avid Unity MediaNetwork v 5.0.x shipped with two 1-GB modules (2-GB) in the media 
engine. This configuration is still supported in Avid Unity MediaNetwork v 5.1 as long as 
you do not install 1 TB drives in the media engine and MEDIArray drive enclosures, or do 
not have more than four attached MEDIArray drive enclosures.

To support more than four attached MEDIArray drive enclosures or 1 TB drives, you need to 
increase the memory in the media engine from 2-GB to 4 GB of memory. Media engine 
memory upgrade kits are available from Avid. For more information, see your Avid 
representative.

6 PCI-X Fibre Channel The ATTO CTFC-41XS adapter board used to connect 
to a Fibre Channel switch or additional storage.

This board is standard in the Avid MEDIArray XT. The 
Avid MEDIArray XT and MEDIArray LP drive 
enclosures add additional storage and uses this Fibre 
Channel connection to connect to a Fibre Channel 
switch. 

n The ATTO CTFC-41XS board is installed in slot 3 
of the Avid MEDIArray LP. For more information, 
see “Support for Eight Drive Enclosures” on 
page 12.

The ATTO CTFC-41XS adapter board is optional. It is 
required when adding addition storage to the Avid Unity 
Media Engine.

7 PCIe Internal 3ware® SATA 
RAID

This slot contains a 16-port PCI-Express SATA RAID 
controller that controls the internal drives. No external 
connectors are available. 

Supported Slot Configuration (Continued)  

PCI Slot Interface Description
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Supported Drives for MediaNetwork

Avid Unity MediaNetwork v5.1.x supports 250 GB, 500 GB, and 1 TB drives in the chassis. 
Avid Unity MediaNetwork drives with less storage capacity are not supported in the media 
engine and MEDIArray drive enclosures. As drive size and drive speed improve, newer 
drives are qualified for use. Contact your Avid representative for more product information.

n Avid Unity MediaNetwork v 5.1 now supports 1 terabyte (TB) drives in the media engine and 
MEDIArray drive enclosures. To support 1 TB drives you need to increase the memory 
(RAM) in the media engine from 2 GB to 4 GB. New media engines shipped with Avid Unity 
MediaNetwork v5.1 and later comes with 4 GB of RAM.

MediaNetwork System Configurations

Avid provides information about MediaNetwork configurations that are qualified with each 
MediaNetwork release. This information shows the number of active MediaNetwork clients 
that various MediaNetwork workgroups can support. For configuration information, see 
Avid Unity MediaNetwork Configuration Guidelines. 

n The configuration information is a guideline for MediaNetwork workgroups to use but does 
not provide for all the variations of MediaNetwork workgroups. The number of MEDIArray 
drives in the data drive set, the use of real-time effects, and digitizing or recording to a 
protected or unprotected workspace while other users are working are factors that affect 
MediaNetwork workgroup performance. Also, you might find that MediaNetwork workgroup 
performance decreases as the individual clients’ loads increase. 

Port Blocking

Some users need to block ports on the Avid Unity Media Engine to protect their systems. 
The following information provides you with the default Ports used by Avid on the media 
engine. Other ports are not used by Avid and can be blocked without causing problems with 
their system.

Defaults Ports Used: 

• 5000 - Fail Over File Manager. This is read in from the registry. If the default port has 
been changed using the Setup Manager, the media engine will use a new port.

• 6010 - Avid Unity Media Engine workgroup configuration

• 6012 - Avid Unity Media Engine load balancing for workgroups. Not likely used, but 
not blocked.

• 6014 - License server
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The following ports allow CIFs authentication on a Avid Unity Media Engine:

• 137, 138, 139, and 445

• 53 - Depending upon your setup you might need to open port number 53 to allow 
Domain Name Services to connect on a Avid Unity Media Engine.

Avid MEDIArray Drive Enclosures

The Avid MEDIArray drive enclosures are PC-compatible systems that run the Windows XP 
Professional operating system. The Avid MEDIArray drive enclosure must be dedicated to 
service only the workgroup. Install only the Avid MEDIArray workgroup software and other 
Avid-authorized software on the Avid MEDIArray drive enclosure. 

Memory Configuration

The Avid MEDIArray drive enclosures ship with two 512 MB modules installed for a total 
of 1 GB of memory.

Daisy Chaining

The Avid Unity Media Engine or Avid MEDIArray drive enclosures do not support daisy 
chaining.

Installing MediaNetwork Software 

The following sections describe how to install your MediaNetwork software. Avid ships all 
new media engines and Avid MEDIArray drive enclosures with the appropriate operating 
system, drivers, and hotfixes already installed. 

n Check the Avid Knowledge Base for the Security Guidelines and Best Practices document for 
information on updates for all hotfixes and patches.

When you have completed the installation of the Avid Unity Media Engine software, 
continue with the installation of the client software. Read the “Client Software Installation” 
on page 35 and then use the Avid Unity MediaNetwork Client Guide for more information.
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Software Upgrades

When upgrading your Avid Unity MediaNetwork software on your Avid Unity Media 
Engine, use the new installer DVD to upgrade to the new software. When you run the 
software installer from the DVD, you are guided through the upgrade process which will 
first remove the older version, then install new version. 

Avid Unity Media Engine and TransferManager

There is an intermittent interaction problem between the MediaNetwork software on the 
Avid Unity Media Engine and the TransferManager. If you stop the MediaNetwork software 
while the TransferManager has workspaces mounted for transferring media, both the Avid 
Unity Media Engine and the TransferManager must be rebooted. After both systems are 
rebooted, the TransferManager shows all of the Avid Unity Media Engine drives mounted as 
local drives in the My Computer window. Because the TransferManager does not know 
about these drives, double-clicking a drive displays a message asking if you want to format 
the drive. If you see this message, click No.

To unmount each of the Avid Unity Media Engine drives from the TransferManager:

1. Right-click the My Computer icon on the desktop, and select Manage. The Computer 
Management window opens.

2. In the left pane of the Computer Management window, click Disk Management. The 
right pane shows a list of available drives.

3. Right-click a drive other than C or D (these are the system software drive and the Avid 
software drive), and select Change Drive Letter and Path. The Change Drive Letter and 
Path for X appears, where X is the drive letter.

4. Select the drive in the dialog box and click Remove.

5. Click Close. The drive no longer appears in the right pane of the Computer Management 
window.

6. Repeat steps 1 to 5 for each of the Avid Unity Media Engine drives.

7. Reboot the TransferManager.

Time Synchronization

Avid recommends that you run only one time synchronization utility on your workgroup 
clients. You should use only one of the following recommendations when setting up time 
synchronization:

t Synchronize the Avid Unity Media Engine to a synchronization source and then 
synchronize all workgroup clients to the media engine.
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t Synchronize the Avid Unity Media Engine and all the clients to the same 
synchronization source.

For a MediaNetwork client to synchronize its time with the Avid Unity Media Engine, the 
client needs to maintain a connection to the Avid Unity Media Engine. The connections are 
created as follows:

• Windows Fibre Channel clients automatically create a connection to the Avid Unity 
Media Engine when the client boots. No workspaces need to be mounted.

• Macintosh Fibre Channel clients, or Windows and Macintosh Ethernet clients must 
mount a workspace to create a connection to the Avid Unity Media Engine.

Client Software Installation

As you install the MediaNetwork software on your clients you need to be aware of some 
general information that is not in the manuals. The following sections explain that 
information.

n The Avid Unity MediaNetwork server and client software have separate installer DVDs.This 
reduces the number of splash screen selection previously documented in the Avid Unity 
MediaNetwork Client Guide. 

To install the client software:

1. Load the Client Installation DVD into the client workstation DVD drive.

Wait for the auto-play to display the splash screen.

2. Click Install Products.

3. Click the appropriate installer for your client and follow the prompts:

t Fibre Attach Client

t Ethernet Attach Client

User Permissions

The following is a summary of the permission needed when installing and using the 
Avid Unity client software on Windows and Macintosh workstations:

• Macintosh client — The Administrator name and password are required to install the 
Macintosh client software. All users have full client functionality.

• Windows XP client — A user account with Administrator privileges are required to 
install the client software. A user may be either a Power user or a Restricted User for full 
client functionality. 
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• Windows Vista client — The Administrator name and password are required to install 
the client software. A user may be either a Standard user or an Administrator user for 
full client functionality. 

Installing Windows Clients

Windows Autologin

Avid recommends that you turn off the Windows Autologin feature that takes you directly to 
a desktop when you boot the system rather than displaying a login window. Autologin 
prevents some necessary Avid files from initializing properly and this prevents the 
Connection Manager from mounting workspaces on the desktop. For information about 
turning off Autologin, see your Windows documentation or Help.

Installing Mac OS X Clients

The following sections apply to Mac OS X client installations.

Mac OS X Autologin

Avid recommends that you turn off the Mac OS X Autologin feature that takes you directly 
to the desktop when you boot the system rather than displaying a login window. Autologin 
prevents some necessary Avid files from initializing properly and this could prevent the 
Connection Manager from mounting workspaces. For information about turning off 
Autologin, see your Apple documentation or Help.

Fibre Channel and Ethernet Client Software

Avid does not support running both the Fibre Channel client software and the Ethernet client 
software on the same Mac OS X client.

Connection Manager

The Connection Manager can display up to 400 workspaces in the Connections Manager 
window.

DNS Server

Mac OS X Ethernet clients need to connect to a network that has a domain name services 
(DNS) server so that they can properly identify servers and clients that are part of the 
network. If you do not plan on connecting the MediaNetwork workgroup to a network that 
contains a DNS server, Avid recommends that you install and configure a DNS server on 
your media engine. To install and configure the DNS server, see the Appendix in the Avid 
Unity Media Engine and Avid MEDIArray XT Setup Guide.
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Automatic Software Updates

Avid recommends that you do not automatically update any of the Apple software on your 
Mac OS X client. Automatic Apple software updates can lead to unpredictable Avid 
software behaviors.

To turn off automatic software updates:

1. Select the Apple P menu > System Preferences. The System Preferences window 
opens.

2. Click Software Update. The Software Update window opens.

3. Click the Update Software tab. The available update options appear.

4. Deselect the “Check for updates” radio button.

5. Close the Software Update window to save the change.

Background Tasks

Mac OS X runs several background tasks daily, weekly, and monthly. The tasks clean up 
system databases and run between 3:15 A.M. and 5:30 A.M. If these background tasks are 
missed for a period of time, they can take several minutes to complete, they run at a higher 
system priority from Avid applications and utilities, and will affect the performance of all 
running applications while they are in progress.

If you normally use your system during the time when the background tasks are running, 
consider changing the time when these tasks run. A utility, CronniX, allows you to easily 
change the time when the background tasks run. It is available from the following Web site:

http://www.koch-schmidt.de/cronnix/

Macintosh Hidden Files

When a Mac OS X client writes files to workspaces, it actually write two files: a visible file 
and a hidden file (the resource fork). Visible files usually contain only an icon from the 
creator application and the name of the file. The hidden files appear as an icon followed by a 
period (.), an underscore (_), or the file name on Windows clients.

n The Mac OS X version of Avid Composer Products software does not create hidden files.

When you encounter a hidden file, you should do the following:

• Leave the hidden files as they are. Do not delete or remove these files from the 
MediaNetwork workspace.

• Open files by clicking the visible file name or the visible file icon.

http://www.koch-schmidt.de/cronnix/
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Information About Avid Unity Media Engine

The following sections provide information that you should know regarding all Avid Unity 
MediaNetwork workgroups.

Fibre Channel Adapter Boards

Avid Unity Media Engine systems support one ATTO CTFC-41XS (PCI-X) adapter board 
for connecting a Fibre Channel switch, which in turn connects clients and additional storage. 

Disk Software

When you use your Avid Unity Media Engine you might run in to the following scenarios, 
they appear as problems, but they are not.

• When you open the Setup Manager you might observe disks that are labeled something 
other than Avid. 

• While creating a new Data Drive set it is possible to receive a dialog box that reads:

Some of the selected drives may not have the correct firmware

Click OK and ignore the dialog box.

Neither of these situations effect system performance and should not be cause for concern. 
The software that determines the drive type and firmware is being changed to reflect to the 
proper drives. 

Hot Swapping Avid Unity Media Engine System Drives

The Avid Unity Media Engine does not support hot swapping the drives in the drive set. You 
should not remove a drive from a Avid Unity Media Engine while it is running.

Avid Unity Media Engine Directory and File Limits

Avid Unity MediaNetwork v5.x supports 10,000 directories and up to 500,000 files. You can 
increase the number of directories on the file system to more than 10,000. Doing so, 
however, decreases the total number of files you can store, by 32,000, each time you cross a 
10,000-directory boundary. MediaNetwork warns you if you exceed either the directory or 
the file limits. The following table shows the dynamic relationship between the number of 
directories you have and the number of files you can store on a Avid Unity Media Engine 
with 2-GB of memory.
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Workgroups and Sound Designer II Audio Files

Sound Designer II™ files are not supported on Macintosh clients in a workgroup. Do not 
import existing projects with Sound Designer II files into Avid Unity MediaNetwork system. 
For new projects, use a different default file format, such as AIFF-C.

Starting New Projects or Converting Existing Projects

To set the audio file format when you start a new project or convert an existing project:

1. Double-click Audio Project in the Settings scroll list of the Project window.

2. Click the Audio File Format pop-up menu, and select either OMF (AIFF-C) or OMF 
(WAVE).

3. Click OK. Any Sound Designer II files you subsequently import or digitize are 
converted to the selected format.

Problems with Existing or Converted Projects

To fix Sound Designer II files in a converted or existing project where the Sound 
Designer II format was not converted:

1. Make a list of the files that are presenting problems.

2. Recapture or reimport the files and convert them to either OMF (AIFF-C) or OMF 
(WAVE).

Avid Unity Media Engine Directories and Files  

Directories Maximum Files Avid Unity Media Engine

10,000 500,000

20,000 468,000

30,000 436,000
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Loading Fibre Channel Firmware and Drivers

If you have purchased a new Avid Unity MediaNetwork system, you might need to load new 
ATTO HostBusAdapters drivers on your Windows or Mac OS X editing systems. Avid Unity 
MediaNetwork software DVD includes the needed drivers, firmware, and configuration tool 
for the supported boards. For a list of supported driver version, see “Fibre Channel Adapter 
Board Firmware and Drivers” on page 28.

n Avid has loaded the proper firmware on the ATTO Celerity board prior to delivery of your 
system.

Installing the ATTO Configuration Utility on Mac OS X Systems

The ATTO Configuration Utility allows you to:

• Upgrade the firmware on the ATTO Fibre Channel adapter board.

• Display adapter specific settings.

• Display connected devices.

To install the ATTO configuration utility:

1. Log in as Administrator.

2. Insert the MediaNetwork DVD into the DVD drive. The Avid Unity Installation window 
opens after approximately 1 minute.

3. Click the Exit button to close the installation window.

4. On the Avid Unity MediaNetwork DVD, browse to (4 Gb board):

[DVD]:\Drivers_Firmware\HostBusAdapters\ATTO\Utilities\Windows\3.14\
win_app_configtool_314.exe

5. Double-click the win_app_configtool_314.exe file (4 Gb board).

The ATTO Configuration Tool Window opens.

6. Click Next. The License Window opens.

7. Select “I accept” and click Next. 

The Choose Install Folder window opens.

8. Click Next, or change install path and click Next. The Pre-Installation Summary 
Window opens.

9. Click Install. When the installation is complete the Install Complete Window opens.

10. Click Done.
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Upgrading the ATTO Phantom Device

n You only need to upgrade the ATTO Phantom Device if you have not done it in previous 
releases. If you have performed this procedure in any other release you can skip this 
procedure.

The ATTO Phantom Device will only load when the ATTO Fibre Channel adapter board 
cannot find any devices. To upgrade this device, you must disconnect the Fibre Channel 
cable from the ATTO Fibre Channel adapter board. The ATTO Phantom Device will appear 
in the Device Manager after you disconnect the Fibre Channel cable. Keep the cable 
disconnected until the firmware upgrade is complete.

To upgrade the ATTO Phantom Device:

1. Disconnect Fibre Channel cables from the ATTO adapter board.

2. Right-click on My Computer and select Manage. The Computer Management Window 
opens.

3. Select Device Manager. The Device Manager opens.

4. Click the plus sign (+) next to System Devices.

5. Right-click on the ATTO Phantom Device and select Properties.

6. Click the Driver tab in the Properties window.

7. Click Update Driver in Driver tab.

8. In Upgrade Device Driver Wizard.

- Do not let Windows select the driver, click the options that allow you to pick the 
driver.

- Navigate to the ATTOMTLN.inf file on the DVD.

9. Click Open in the Locate File Window. You will receive an incorrect list of devices in 
the Select a Device Driver Window. The Phantom Device has changed from a SCSI and 
RAID device to a System device.

n This process applies to the first Phantom Device you upgrade on the system. After you 
upgrade the first device, on systems with multiple Phantom Devices, subsequent devices 
display the correct System device.

10. Click Next in the Select Device Driver Installation window.

11. Click Finish. The driver version of the Phantom Device should be v1.0 in the Properties 
window you opened in step 5.

12. Close the Properties window.

13. Repeat steps 5 to 19 for each Phantom Device listed.

14. Reconnect the cables.
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Upgrading the ATTO Fibre Channel Driver on the Avid Unity Media Engine

Use the following instructions to upgrade the ATTO Fibre Channel driver in your Windows 
Fibre Channel client or Avid MEDIArray.

To update the ATTO v2.51 to v2.61 scsiport driver on the Avid Unity Media Engine:

1. Navigate to C:\windows\system32\drivers on the media engine.

2. Rename the ClrtyFC.sys driver to ClrtyFC.251.

3. Copy the scsiport version of ClrtyFC.sys file from the Avid Unity MediaNetwork DVD 
to the C:\windows\system32\drivers folder. The location of the scsiport ClrtyFC.sys file 
on the DVD is:

[DVD drive]:\Drivers_Firmware\HostBusAdapters\ATTO\Drivers\Windows\
Celerity\2.61\32bit\

4. Restart the media engine.

5. To verify that the correct driver was installed, navigate to C:\windows\system32\drivers 
on the media engine.

6. If the description says storport then rename the ClrtyFC.sys file to ClrtyFC.storport.

7. Right-click the ClrtyFC.sys driver and select Properties.

8. Click the Version tab.

Under the Description, it should say “Celerity HBA Windows x86 scsiport driver.”

Upgrading the ATTO Fibre Channel Driver on Clients or Avid MEDIArray Enclosures

Use the following instructions to upgrade the ATTO Fibre Channel driver in your Windows 
Fibre Channel client or Avid MEDIArray.

n You must be logged in as an Administrator to upgrade drivers.

1. Insert the MediaNetwork DVD into the client DVD drive. The MediaNetwork software 
installation window opens after approximately 1 minute.

2. Click the Exit button to close the installation window.

3. Browse for the CTFC-4xxx driver on the MediaNetwork DVD, go to:

\Drivers_Firmware\HostBusAdapters\ATTO\Drivers\Windows\Celerity\2.61

4. Double-click Setup.exe.

The ATTO Windows Driver Installer opens.

5. Click Install.

A setup installation message appears. 
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6. Click OK in the message box.

A Hardware Installation message informs you that the driver does not pass the Windows 
Logo testing. 

7. Click Continue Anyway (Windows XP) or click Install this software anyway (Windows 
Vista) at the Hardware Installation dialog box.

A message informs you that the ATTO Windows driver installation has completed 
successfully. 

8. Click OK.

n There is a FakeComm driver window that appears immediately after installing the ATTO 
driver for the first time or for some reason when the switch ports have changed (bad ports or 
moved fiber cables). The window appears because the “target” ports need to be configured 
or reconfigured with the new location of the fiber cable. Whenever the FakeComm driver 
request window appears, choose the default option “Locate and Install driver software 
(recommended).” The ATTO drivers will be located, installed and it will configure the target 
port.

Upgrading the ATTO Firmware

You do not need to update any ATTO firmware for Avid MediaNetwork v5.x but this 
procedure is provided for any future need that might arise. Make sure the Fibre Channel 
cables are disconnected from the ATTO Fibre Channel adapter board before you proceed.

To upgrade the ATTO firmware using the ATTO Configuration Utility:

1. Click the Start button, and select Programs > ATTO Configuration Tool > Configuration 
Tool. The Configuration tool opens.

2. From the Device Listing window, click the plus sign (+). The Hosts Window opens.

3. Click the plus sign (+). The Localhost Window opens.

4. Click the ATTO CTFC-4xxx that appears under localhost.

5. Click the Flash tab that appears to the right of the Main Window.

6. Click the Browse navigate the Avid Unity MediaNetwork DVD to the flash bundle 
file stored at: 
Drivers_Firmware\HostBusAdapters\ATTO\Firmware\Windows\Celerity\2.50

7. Click on the flash bundle and click Open.

8. Click the Update button.

n The system appears to hang for several seconds while the flash occurs.

9. When the flash completes, click OK and quit the Configuration Utility.

10. Reboot the Windows client for changes to take effect.
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n If you have multiple ATTO Fibre Channel adapter boards to upgrade, click No to the reboot 
message until you have completed upgrading all of the boards in your system and then 
reboot the system before upgrading the MediaNetwork software. 

When you have completed installing the ATTO driver and firmware, return to the procedure 
that directed you here and complete the upgrade procedure.

Software Install Order with Mac OS X Systems 

Install the software in the following order: 

• Install the ATTO drivers and firmware (if needed) on your Macintosh client system

• Load the v5.0.1.10 firmware into the new MEDIASwitch 16-4Gb (Q-Logic)

• Install your Avid Unity MediaNetwork software on your Mac OS X 10.4.11 or later

n When installing software on the Macintosh system you will need the Administration 
Password. 

Installing ATTO Drivers and Firmware on Mac OS X Systems

The following sections describe how to upgrade ATTO firmware and drivers for the 
Mac OS X operating system. Load the drivers and firmware for the ATTO boards on 
Windows Operating system, see “Upgrading the ATTO Fibre Channel Driver on Clients or 
Avid MEDIArray Enclosures” on page 42.

Installing the ATTO Configuration Tool 

The ATTO Configuration Tool allows you to:

• Upgrade the firmware on ATTO Fibre Channel adapter boards.

• Display adapter specific settings.

• Display connected devices.

To install the ATTO Configuration Tool:

1. Insert the Avid Unity MediaNetwork DVD into the Macintosh client DVD drive.

2. Disconnect the Fibre Channel cable from the ATTO Fibre Channel adapter board in the 
Mac OS X client.

3. On the MediaNetwork DVD navigate to (ATTO 4-Gb Celerity):

[DVD]:Drivers_Firmware_Mac\HostBusAdapters\ATTO\Utilities\OSX\
3.16\osx_app_configtool_316.dmg

4. Double-click Configuration application (.app). The ATTO Configuration Tool window 
opens.
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5. Enter the Administrator password.

6. Follow the on-screen prompts accepting the recommended defaults. 

7. When the Install Complete screen appears, click Done.

8. Reconnect the Fibre Channel cable.

9. Restart the Mac OS X client.

To upgrade the ATTO Fibre Channel driver:

1. Insert the MediaNetwork DVD into the Macintosh client DVD drive. 

2. On the MediaNetwork DVD, navigate to: (for ATTO Celerity CTFC-41XS board)

[DVD]:Drivers_Firmware_Mac\HostBusAdapters\ATTO\Drivers\OSX\

Celerity\3.21\

3. Double-click the osx_drv_celerity_321.dmg

4. Double-click the ATTOCelerityFC_321.pkg. 

5. Follow the on-screen prompts accepting license agreement and the recommended 
defaults to install the software. 

6. When the driver installation finishes, restart the Mac OS X client. 

Loading Firmware into the MEDIASwitch 16-4Gb

Avid Unity MediaNetwork v5.x software uses the MEDIASwitch 16-4Gb or the 
MEDIASwitch 10 4-Gb. If you are installing a new system the proper firmware is already 
loaded. No Firmware update is necessary on the MEDIASwitch 10 4-Gb switch at this time. 
If you are bringing forward an existing MEDIASwitch 16-4Gb, a firmware update is 
required. 

To load the firmware into the MEDIASwitch 16-4Gb you need the following: 

• The new version 5.0.1.10 firmware 

• A crossover cable 

• An installed Avid Unity system with SANsurfer software installed on a PC. This would 
normally be the media engine. 

To load the new firmware:

n If you have two MEDIASwitch 16-4Gbs and the media engine and switches are connected to 
an Ethernet network, you should turn off one switch before running MediaSwitch Manager 
16 software for the first time to configure the switch IP addresses. This prevents the software 
from seeing duplicate IP addresses that can cause it to not recognize either switch. 
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To install MEDIASwitch 16-4Gb software:

1. Click the Start button and point to Programs > MediaSwitch Manager, and select 
MediaSwitch Manager.

n If you have previously stored the default fabric view you will be asked to enter the encryption 
code. Do not type anything in, just click OK and continue to step 4.

2. Click one of the following:

t If you have a view already loaded click Load View File - Go to Step 7

t If you do not have a view already loaded click Continue Without Loading View — 
Go to step 4.

3. Click Add. (this requires IP address, login, and password) and click Proceed.

The Add a New Fabric window opens.

4. Enter the following:

- The IP address of the switch For example; 192.168.1.129

- At login: enter admin 

- AT password: enter password (all lower case)

5. Click Add Fabric

6. A Non-secure connection window opens, click OK.

The Topology window opens, showing you the selected switch in your Fabric.

7. Click the handle in the left pane of the window. This displays the switches that are in 
your Fabric using the Switch Faceplate view.

8. Double-click the Switch in the left pane that you need to load firmware.

9. From the Switch Menu select Load Firmware. The Load Firmware window opens.

10. Click Browse from the Load Firmware window and browse to the location of the new 
v5.0.1.10 firmware file. 

11. Select the file and click Open.

12. From the Load Firmware Window click the Start button.

A Firmware Upload Message box opens. 

Handle

Switch
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13. Click OK to continue the installation.

When completed an “Activate Successful” message appears.

14. Click “Close” to exit the Firmware Utility when the firmware has been loaded.

15. Close all open windows and programs.

Using the Product Recovery DVD

If you need to restore your media engine or other MediaNetwork systems by installing the 
Product Recovery DVD, remember that the procedure restores only the operating system 
and drivers. It does not restore the MediaNetwork software. The MediaNetwork software 
must be reinstalled separately, after the operating system recovery is complete.

When recovering the Windows operating system, you need to run the Windows Setup utility 
to set the operating system parameters. You need to have the Windows license number to 
type in as part of the configuration. Depending on the Windows operating system you are 
using, Avid provides the Window operating system license number on a sticker on the side 
of the chassis. This sticker is shipped in the box and must be attached to the side of the 
enclosure when setting the media engine or MEDIArray XT.

c If reimaging the MEDIArray LP, you must use the Product Recovers DVD from the 
Avid Unity MediaNetwork v4.2.x release.

For an updated procedure on how to use Avid Product Recovery DVDs and perform the 
Windows Activation process, search for the “Product Recovery DVD and Windows 
Activation Process” posted on Avid Knowledge Base. Go to www.avid.com/onlineSupport/. 

Using Backup Software

There are several non-Avid applications available for backing up your Avid Unity system: 

• Legato NetWorker®

• ARCserve®

• Dantz Retrospect®

You’ll need the following hardware to perform these backups:

• A separate server to run the server portion of the backup software, if required. This 
server cannot be the media engine.

• A tape drive, attached to the backup server, that is supported by the backup software.

http://www.avid.com/onlinesupport
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• A client attached to the workgroup that can mount all of the MediaNetwork workspaces. 
This can be either a Windows or a Macintosh client, as supported by the backup 
software, that is already a workgroup client.

For additional information on using these backup applications to back up your 
MediaNetwork workgroup, see the backup application notes included with your 
MediaNetwork documentation or contact Avid Customer Support.

Documentation Change

The following are updates to the Avid Unity MediaNetwork Administration Guide. 

Recovering and Replacing Drives

The Avid Unity MediaNetwork Administration Guide describes how to replace a drive in 
Appendix A under a heading “Recovering and Replacing.” You now must restart your Avid 
Unity MediaNetwork before you can designate a replacement drive as a spare. The process 
has been updated since the guide was published, the updated procedure is as follows:

n This procedure assumes you had a drive designated as a spare before the failure.

c If you do not have a spare drive designated and experience a drive failure, this 
procedure does not apply and you are at risk of data loss if a drive fails.

To perform a drive recovery:

1. Select Start > All Programs > Avid Unity > Setup Manager.

The Setup Manager window opens.

2. If the Data Drive Set group is not already selected in the Available Drive Groups list, 
click its entry to display all the attached active and spare data drives.

3. Ensure that there is a spare, same-size data drive to replace the failed data drive.

4. Ctrl+click the drive to be replaced and the spare drive to select them.

5. Select Recover > Recover Failed Data Drive.

The Recover Confirmation dialog box opens. 

6. Click Yes to recover the selected drive.

A dialog box opens, asking you to choose to leave clients connected or disconnect them.

7. Do one of the following:

t Click Yes to start the online drive replacement.

t Click No if you want to disconnect all clients and perform an offline replacement.
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A progress indicator appears, showing that the Setup Manager is performing an 
online drive recovery. Writing to disks is blocked for a brief period at the end of 
online recovery.

When the data drive set has been recovered from an online repair, the progress 
indicator closes. A dialog box informs you that the previously spare drive appears in 
the Data Drive Set group marked as active, and the previously active drive that was 
replaced appears as a Replaced Drive.

When the repair has completed, you need to determine which physical drive is bad 
within the drive enclosure.

8. Highlight the drive that was replaced (bad), and select Drive > Identify.

The selected drive in the drive enclosure to blink for 15 seconds.

n Any of the other drives can blink while transferring metadata. If possible, you should watch 
when you select Identify to determine the actual drive that needs repair. Be sure to note 
which drive is identified to make sure you know which drive should be replaced. (For 
example, you could be to place a small piece of tape on the front of the drive.)

9. Select the replaced (bad) drive, right-click the drive and select ‘Take drive offline from 
controller.”

10. Manually remove the problem drive from the drive enclosure, replace it with a new disk 
drive.

The newly installed drive spins up but cannot be accessed until the Media Engine is 
restarted. If the replacement drive was in the MEDIArray drive enclosure, it also must 
be restarted.

c If you had a drive designated as a spare before the failure, you can continue to work 
without interruption, Although if you have a second failure without a designated spare 
drive. you could experience data loss.

11. When time permits, shut down the system in the following order:

a. Clients

b. Media Engine

c. MEDIArray drive enclosure

12. Start the components in the following order:

a. MEDIArray drive enclosure

b. Media Engine

c. Client
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n Once the components are restarted, the new disk drive is now a raw drive. You must continue 
with the procedure and use the Setup Manager software to make it a spare drive.

13. If the Setup Manager is not already running, select Start > All Programs > Avid Unity > 
Setup Manager.

The Setup Manager opens.

14. Select Raw Drives in the Available Drive Groups list. 

The raw drives discovered by the Setup Manager are displayed in the right panel of the 
window.

15. Select the raw drive in the Drives list.

16. Select Drive > Make Drive Spare.

The drive becomes a spare data drive and is moved from the Raw Drives group into the 
Data Drive Set group.

17. Close the Setup Manager.

The File Manager now sees the drive as a spare.

Take Drive Offline from Controller Option

The “take drive offline from controller” option in Setup Manager applies to fiber attached 
MEDIArray storage enclosures only. Although not dimmed in the menu, you cannot “take 
drive offline from controller” on any of the storage drives located in the media engine 
enclosure. You must power down the media engine to remove drives from the media engine. 

Once the media engine has restarted, the new disk drive is now a raw drive. Use the Setup 
Manager software to make it a spare drive.

Improved Behavior During Online Drive Repair

The existing Avid Unity MediaNetwork Administration Guide states the following when 
performing an online drive recovery:

“Clients that are not already connected to the MediaNetwork workgroup (by having a 
workspace mounted or by running the Administration Tool) are prevented from connecting 
to the workgroup until the recovery is complete. If a connected client logs off or crashes 
during disk repair, they will not be able to reconnect.”

The new behavior:

Clients are able to unmount and remount workspaces as many times as needed during online 
drive repair, but can expect degraded performance till repair completes.
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Limitations

The following items describe limitations with the current release of the MediaNetwork 
software. When a workaround exists, it appears in the paragraph directly following the 
limitation description.

➤ If you use the Avid Performance Meter (IOTester.exe) to perform a read-only test, and you 
stop the test before it completes, the tool might stop functioning unexpectedly. This can 
occur if you try to stop the test while it is creating a temp file. 

n Stopping the Performance Meter during a write-only test does not result in the same 
problem.

Workaround: Monitor the progress of the test in the Results graph and, if necessary, stop 
the test when the tool is recording reads and not writing a temp file.

➤ If you use the ATTO Configuration tool to upgrade the firmware on the ATTO Fibre Channel 
host adapter board, the Connection Mode setting reverts to the default setting of AL 
(Arbitrated Loop), and the Interrupt Coalesce setting reverts to the default setting of Low.

You must restart your system after a firmware update is applied. After the restart has 
occurred, you must reconfigure your board as appropriate for your operating environment. 
To reconfigure your board, see “ATTO Configuration Mode Settings” on page 17 and you 
must restart your system a second time after the configuration is completed to apply the 
values.

➤ If you have a data file that is larger than the free space, you receive a “Some files were not 
optimized” error. 

Workaround: When you optimize, you make a copy of a file on a nearly full workspace or 
drive, move it to an emptier workspace or drive, then delete the original. You must maintain 
sufficient free space on your workspace or drive to make a copy of your largest file, or 
optimization will fail. Be aware that the size of files when using MXF, starting in v3.5.3, is 
vastly larger than what is possible with OMF files. 

➤ All versions of the Mac OS operating system are not case sensitive. You cannot have two 
files with the same name, but different letter case, in the same folder (such as, video1 and 
Video1).

The MediaNetwork file system is case sensitive. You can have two files with the same name 
and different letter case in the same folder. This might cause problems for MediaNetwork 
workgroups that have a mix of Windows and Macintosh clients.
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Known Issues

The following sections describe known issues with the Avid Unity Media Engine hardware 
and software. When a workaround exists, it appears in the paragraph directly following the 
issue description. 

MediaNetwork

➤ When you Log off of the Avid Unity Media Engine from the console or from a remote 
desktop session while other Ethernet attached clients are performing I/O operations, the 
editing applications pauses for a few moments. This behavior is experienced on all releases 
of Avid Unity MediaNetwork. This is a limitation with the Windows operating system.

Workaround: The I/O operation continues after retrying the operation. It is not necessary to 
restart the Avid Unity Media Engine. 

➤ Windows Vista Ethernet clients might experience slow performance when you drag and drop 
files into workspaces. This is caused by the Windows TCP autotuning in the Avid Unity 
Media Engine. 

Workaround: Apply the Windows Server 2003 hotfix Article ID number 947773 to your 
Avid Unity Media Engine. For more information, view the article in the Microsoft 
Knowledge Base.

As an alturnitive to the Windows Server 2003 hotfix, you can also open a comand prompt on 
the Window Vista client and type the following:

netsh interface tcp set global autotuninglevel=disabled

➤ If your Windows XP client repeatedly logs the following events in its system event log, 
perform the DataCacheSize DWORD Workaround.The event source is “avidcomm.”

Requested read operation failed with status = 
STATUS_INSUFFICIENT_RESOURCES

 or

Requested write operation failed with status = 
STATUS_INSUFFICIENT_RESOURCES

Workaround: Create or change the DataCacheSize DWORD value in the registry.

To create or change the DataCacheSize DWORD value:

1. Click the Start button and select Run. 

The Run window opens.
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2. Type regedit. 

The Regedit window opens.

3. Navigate to:

HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/avidcomm/
CacheParams/

n If you already have a DataCacheSize DWORD entry, continue with step 6 and change the 
value to 8.

4. Click Edit > New and select DWORD Value.

5. Type the name of the DWORD Value as “DataCacheSize.”

6. Double-click the DataCacheSize values name. 

The Edit DWORD Value dialog box opens.

7. Type the Value data as “8” and select Decimal.

8. Click Ok.

9. Close the Registry Editor window (File > Exit).

10. Restart the Windows XP client. 

➤ For media engines and for Avid Fibre-attached clients, Windows XP might display the 
following error message after you repeatedly restart the system: “Windows — Low On 
Registry Space.” This occurs when the Windows system hive file increases in size because of 
the large number of drives in the MediaNetwork system for which Windows XP maintains 
registry records. This can degrade the performance of the media engines and of 
Fibre-attached clients.

Workaround: Run the Scrubber.exe utility located in the \Extras\Scrubber folder on the 
Avid Unity MediaNetwork DVD to remove old entries and compresses the system hive file. 
For information on how to run the Scrubber utility, see the documentation provided in the 
Scrubber folder on the DVD (Microsoft_Scrubber_util.doc).

➤ If there are a large number of files (typically greater than 100) opened by Windows Vista 
Ethernet attached clients, the Media Engine could start to run out of non-paged resources. 
This would be seen as “insufficient resources” or similar events in the system event log of 
the Media Engine.

➤ If you cancel the software uninstall process on the MediaNetwork or any Windows client 
before the software is removed, when the client reboots, an error message opens stating that 
it cannot find the setup.exe file. This prevents the new client software from being installed.

Workaround: Restart the software uninstall process and complete uninstalling the software.
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➤ If you select No to the License Agreement during the Avid Unity MediaNetwork software 
installation and then select No when asked if you want to quit the setup, an error message 
appears stating “InstallShield can not call DLL function: GetDlgItem.”

You must accept the License Agreement to install the software.

Workaround: Click OK to clear the error message; you are brought back to the License 
Agreement. To exit the setup, click No to accepting the License Agreement, then Yes to “are 
you sure you want to quit the setup.”

➤ The Monitor Tool does not report any Ethernet clients in the Active Clients tab. The tab 
currently only reports Fibre Channel clients.

Workaround: To see information about the Ethernet clients, use the Status Viewer. 

Administration Tool

➤ The Administration tool might display a size for a drive that differs from the size displayed 
for the same drive in the Setup Manager or in the Avid Unity MediaNetwork Monitor tool. 
The drive size listed in the Setup Manager and in the Monitor tool represents the actual size 
of the drive. The drive size listed in the Administration tool represents the size of the drive 
with the metadata area (104 MB) taken into account.

➤  A Drive Repair will not start if the Administration tool is open on the media engine. The 
repair seems to start, but in the Server Log viewer it will just wait and make no progress. 

Workaround: Close the Administration Tool, then navigate into a workspace through 
Network Neighborhood. Once that was done the data copy started.

Windows Clients 

➤ After you mount workspaces, re-opened the connection manager to deselect some 
workspaces then select others, one of the following can take place:

- The correct number of drive letters are displayed, but one or more of the drives 
show the wrong workspace name (it is really the newly mounted workspace). 

- The deselected workspace disappears but the newly selected workspace does not. 

Workaround: Do not dismount and mount from the Connection manager in the same 
“manage connections” session; For example, unmount the drives, click apply, then re-open 
manage connections to mount the new one. 
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➤ If you delete a workspace from the media engine while a client has the workspace mounted, 
the workspace appears to still be mounted on the client if viewed using Windows Explorer.

Workaround: To check mounted workspaces on a client, start the Connection Manager. 
This updates the mounted workspaces. Any workspaces that were deleted no longer appear 
in Windows Explorer.

➤ If the media engine is rebooted without properly stopping clients, the Windows clients do 
not reconnect.

Workaround: To see the media engine, right click My Computer, select Manage and rescan 
System Devices. 

➤ If two files containing different data, with the names of the files having different cases (for 
example NAME.txt and name.txt), opening either file only shows the data from the file with 
the lower case name (name.txt).

➤ When a client is moved from one switch to another and the client is rebooted, you might 
intermittently see the “Found New Hardware Wizard” appears looking for AVIDCOMM 
FAKE COMM DISK.

Workaround: You can choose to reinstall the driver which is already on the client, or 
dismiss it. If you dismiss it you might receive the message each time you boot the system.

➤ When you log out of a Windows XP client using the Windows Switch User feature, the 
workspaces mounted by the previous user remain mounted when your desktop opens.

Workaround: Use the Windows standard log out process and then log in when the 
Windows log in prompt opens.

Mac OS X Clients

➤ Avid editing Macintosh clients cannot capture 8-bit 1:1 HD media to a mirrored Avid Unity 
MediaNetwork workspace; 10-bit HD media works fine.

Workaround: To capture 8-bit HD media to an Avid Unity MediaNetwork workspace, you 
must unmirror the workspace then capture the 8-bit HD media.

n You can then mirror that workspace after the 8-bit 1:1 HD media is captured. Synchronize 
the workspace with the Administration tool after the mirroring is re-applied



 

56  

➤ Avid Unity Media Network Macintosh OSX clients are allowed to mount up to 256 
workspaces. An error message is not displayed if you attempt to mount more than 256 
workspace.

➤ If the File Manager service is turned off or the media engine powers down for any reason 
such as for maintenance or a system crash, all Mac OS X clients must be rebooted to 
reconnect.

➤ The Administration Tool for Mac OS X clients has Optimize, Synchronize, Add/Remove 
Drives, and Move Workspace options disabled.

Workaround: Perform the Optimize, Synchronize, Add/Remove Drives, or Move 
Workspace operations from the media engine or a Windows client.

➤ Mac OS X clients cannot mount workspaces that have one or more spaces in the workspace 
name. 

Workaround: Create workspaces with no spaces in their names. If you need to separate two 
words in a workspace name, use an underscore (_) instead of a space.

Technical Support Information

Most products feature a number of coverage options. Avid Assurance service offerings are 
designed to facilitate your use of Avid solutions. Service options include extended telephone 
coverage, automatic software maintenance, extended hardware warranty, and preferred 
pricing on replacement parts. Offerings and options may vary by product and are not 
available for all products.

For more information regarding Avid’s service offerings, visit www.avid.com/support or call 
Avid Sales at 800-949-AVID (800-949-2843).

Program availability and details might vary depending on geographic location and are 
subject to change without notice. Contact your local Avid office or your local Avid Reseller 
for complete program information and pricing. However, if you need help locating an Avid 
office or Avid Reseller near you, please visit www.avid.com or call in North America 
800-949-AVID (800-949-2843). International users call 978-275-2480.

http://www.avid.com/onlinesupport
http://www.avid.com
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Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, RetroLoop, rS9, rS18, Salesview, Sci-Fi, Scorch, Scorefitter, 
ScriptSync, SecureProductionEnvironment, Session, Show Center, Sibelius, SIDON, Soft SampleCell, Soft-Clip Limiter, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, Sputnik, Starplay, SteadyGlide, Streamfactory, 
Streamgenie, StreamRAID, Strike, Structure, Studiophile, SubCap, Sundance Digital, Sundance, Symphony, SYNC HD, 
SynchroScience, SynchroScope, Syntax, TDM FlexCable, Thunder, Titan, Titansync, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, Torq, Torq Xponent, Transfuser, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Venom, VideoRAID, Video Slave Driver, VideoSPACE, 
VideoSpin, Vortx, Xdeck, X-Form, Xmon, Xponent, and X-Session are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.
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3ware is registered trademarks of Applied Micro Circuits Corporation in the United States. Apple, Final Cut Pro, KONA, Mac, 
Mac OS, Macintosh, and QuickTime are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. 
ARCserve is a registered trademark of Computer Associates International, Inc. Asante is a registered trademark of Asante 
Networks, Inc. Dantz Retrospect is a registered trademark of Dantz Development Corporation. HP is a registered trademark 
Hewlett-Packard company. Intel is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. Legato NetWorker is a registered trademark of Legato Systems, Inc. QLogic is a registered trademark of QLogic 
Corporation. Windows is a registered trademarks of Microsoft Corporation in the United States and/or other countries. All 
other trademarks contained herein are the property of their respective owners.
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